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Compliance Updates

In this release, we have included updates for Import Service, Reverse Charge
pertaining to GST compliance changes and new feature Send/Receive
e-Invoice through Peppol network. We also added some minor enhancement.

1. ABSS Premier Version 23.2 and ABSS Accounting Version
28.2 are certified to be Windows 10 compatible.

ABSS Premier Version 23.2 and ABSS Accounting Version 28.2 is certified to
be compliant with windows 10 and all other versions of windows. This means
that all windows 10 applications on your computer are tested and certified
to operate with ABSS software concurrently as a single user or multi userin a
windows 10 environment.

Compatible

Ny

Windows  Windows™?

™
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Compliance Updates
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2. Upgrade to the latest ABSS Premier Version 23.2 and ABSS
Accounting Version 28.2 as old versions mentioned below
are being phased out as they have reached the end of their
product lifecycle.

With effect from 1 January 2019, the below versions that are non-
supported in the table are replaced with the latest versions due to windows
compatibility, IRAS compliance issues, feature upgrades and enhancements
mentioned in the below pointers.

This relates to versions below ABSS Premier Version 20 and ABSS Accounting
Version 25 falling under the “MYOB Sunset Policy’, these obsolete versions
have reached the end of their product lifecycle and are no longer supported by
ABSS, they are being replaced with new versions.

The table below indicates which versions are affected; ABSS and our technical
support team will no longer be able to support you for below requests:

« Repair or recover your corrupted business datafiles

« Increase the number of user licenses or number of data files
- Retrieve or reset the master administrator password

« Changing of person in charge of company data files

- General technical support issues

ABSS LATEST OTHER SUPPORTED | NON SUPPORTED
PRODUCT VERSION VERSIONS VERSIONS
ABSS PREMIER V23.2 V20 & 21 <V20
ABSS ACCOUNTING V28.2 V25 & 26 <V25
abss www.andrecorpl.com/abss-accounting-software 2
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Compliance Updates

3. New GST tax types for Import Services and Reverse

Charge

New GST tax type, as shown in below table has been added for use in
line with Inland Revenue Singapore (IRAS) requirement to report
Imported Services, and Reverse Charge.order to access Bank Feeds
service.

Tax Code | GST Sub Type Sub Type Description Transaction Rate | Tax Type
N/A SRRC Auto created from TXRC-TS 7% Sales
OVR SROVR Supply of digital services OVR 7% Sales
TRC Import services incurred (taxable

TXRC-TS supplies) 7% Purchase
RSS Import services (Reg. 33 exempt
TXRC-ESS supplies) 7% Purchase
Ms5 IM-ESS Import goods (Reg. 33 exempt supplies) 7% Purchase
RN3 Import services (Non-Reg. 33 exempt
TXRC-N33 supplies) 7% Purchase
MN3 IM-N33 Import goods (Nen-Reg. 33 exempt 7% Purchase
supplies)
RRE TXRC-RE Import services not attribute to taxable 7 Purchase
or exempt supplies
MRE IM-RE Import goods not attributable to 7% Purchase
taxable or exempt supplies

TXRC-TX, TXRC-ESS, TXRC-N33, TXRC-RE are meant for tracking the
purchase of Imported Services related to Reverse Charge, while
IM-ESS, IM-N33 and IM-RE is use for Import goods.

SRRC is the tax code auto created by the system under Reverse
Charge. SROVR is used for supply of the digital services made by the
overseas suppliers.

In addition, existing tax type TX7 has been renamed to TX, and
TX-ESS has been renamed to TX-E33.
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L

New Tax Code List for newly created data file will be as follow:-

Mot claimable GST [Reqg.2!
Supply of prescribed goods
Deemed supplies

Req. 33 exempt supplies
Mon-Reqg. 33 exempt supplies
FPurchases exempted from GST
Req. 33 exempt supplies
Mon-Req. 33 exernpt supplies
Irmport under deferment scheme
Imports goods with GST 73
Import Duty

Irmports under special scherme
Mon-Reqg. 33 import goods
Mon-dir attributable import go
Req. 33 import goods

MHan-T a=able

Mon G5T-registered supplier
Furchases [Out-of-zcope)
Supplies [Dut-of-scope)

Supply of digital services OWR
G5T not direct atiributable
Mon-Reg. 33 import services
Mon-dir attributable import 2w
Flea 33 import services
Standard-rated supplies(G5T7E)
Furchase of prezcribed goods
Import zervices with GST
Purchazes with GST 7%
Purchazes with no G5T incurred
Zero-rated supplies

GOHB3L DR300 0303003030000 03000380

-

7. | =

Help F1 Frint

¥ 4BSS Premier - [Tax Code List] — Od =
(2 File Edit Lists Command Centres Setup Reports Window Help - 8 X
Code Description Type

Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Import Duty

Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Sales Tax

Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax
Goods & Services Tax

= e e e e i I e B B LR A= I e B =l e s L E = s B B e ] -
T e T T L TR T T T T T L L

Fress F1 to get help. Test.myo
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4. GST F5 [Detail] Report - been updated

GST F5 [Detail] report has been updated to reflected newly added tax
codes for Goods and Services Tax.

GST Sub Type Sub Type Description Taxable Amount Tax Amount
SRRC Auto created from TXRC-TS Box 1 Box 6
SROVR Supply of digital services OVR Box 1 Box 6
U P D AT E D Import services incurred (taxable
TXRC-TS supplies) Box 5 Box 7
G ST F 5 Import services (Reg. 33 exempt
R E P o RT TXRC-ESS supplies) Box 5 Box 7
IM-ESS Import goods (Reg. 33 exempt supplies) Box 5 Box 7
Import services (Non-Reg. 33 exempt
TXRC-N33 supplies) Box 5 Box 7
IM-N33 Import goods (Non-Reg. 33 exempt Box 5 Box 7
supplies)
TXRC-RE Import services not attribute to taxable Box 5 Box 7
or exempt supplies
IM-RE Import goods not attributable to Box 5 Box 7
taxable or exempt supplies

GOODS AND SERVICES TAX RETURN

For The Period July 2019 To September 2019
Date - iD# - Source - Amount -

Box 9: Total Value of Goods Imported Under MES/3PL/0Other Approved Scheme
Total of Box 3 53000

Box 10: Did pou claim for GST you had refunded to tourists?
No]

Box 11: Did pou make any bad debt relief claims/refund claims for RC?
[No]

Box 12: Did you make any pre-registration claims?
[No]

Box 13: Revenue
Total Revenue 5%1.000.00

Box 14: Did you import services subject to GST under reverse charge?
[No]

Box 15: Did you supply digital services on behall of third-party suppliers?
[No]

Box 16: Net GST per box 8 above

5$70.00
Box 17: Defened import G5T payable
[5$70.00)
Box 18: Total tax o be paid to IRAS
5$0.00
Box 19: Total value of goods imported under this scheme
(S$1.000.00) Ra
X L

Notes:

Tax amount of RC related tax code in Box 7 will be calculated based on the
claimable amount according to De Minimis Rule.

User can also click and zoom in the transaction detail from GST F5 Detail
Return report.
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New Features

SEND / RECEIVE E-INVOICE

s E-Invoice Services is an add-on service provided by ABSS Connect
platform, where it allows ABSS Accounting and ABSS Premier user to
send e-invoice to their customer and receive e-invoice from their
supplier.

SEND / RECEIVE o
Prerequisite:
E-INVOICE

a. Must have Internet connection

b. Data file has to be activated
Following describe the changes and how it works:

A.User Sign Up / Login in ABSS Premier / ABSS Accounting
Go to Setup > Company Information

a) Thereis a Connect button, which enable user to signup/login to
ABSS Connect services in order to access e-invoice service.

[ ABSS Premier - [Company Information] — O *

(2 File Edit Lists Command Centres Setup Reports Window Help - 8 x

Company Information

Serial Mumber: |1234 5675 3012 Total Waorkstations Licensed: 1

Company MName: | Cleanwater Pte Ltd

Address: (100 Cecil Street,

12th Floor, The Globe, .

Singapore 053532 UEM Type: | Local Company ]

LIEM No: | 20010421 0H|
Phone Number: | B5-62208530 GET Mo
Fax Mumber: | 65-52208540 G5T Reqg. Date:
Ermnail Address: | zales@clearwater.com G5T De-Reg. Date:
Corversion Maonth:  January 2020 Current Financial Y'ear: 2020
Accounting Periods:  Twelve Last bonth in Financial Year: December

7. | O
Help F1 Licenze || Connect

Prezz F1 ta get help. Cleanwater Pte Ltd.mya

b) Connect button will only be active / clickable if data file been
activated and have not register for ABSS Connect services.

abss www.andrecorpl.com/abss-accounting-software

Formerly known as ('Z:13) South Asia



New Features
]

¢) Click on Connect button will launch Sign Up / Login window, user
who wish to use ABSS Connect services need to Sign Up / Login.

ABSS Connect Sign Up/Login *
Email: |
Passward: |
™ New Sign Up
Name: |

For new user who have not sign up before, please tick ‘New Sign
Up’ check box, and fill up email and password to Sign Up.

For existing user who signed up before, no need to tick ‘New Sign
Up) just Login with the registered email and password.

Once successful Sign Up/Login, message below will be prompt:

After successful registered the company file for ABSS Connect
services,'Connect’ button will become inactive.

2 ABSS Premier - [Company Information] - O X

(2 File Edit Lists Command Centres Setup Reports Window Help -

Company Infarmation

Senial Mumber: | 1234 5675 3012

Tatal wWorkstations Licensed: 1

abss
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Compary MName:

Address:

Phone Mumber:
Fax Mumber:
Email &ddress:

Conversion Month:
Accounting Periods:

7. | O

Help F1 Licenze

Prezz F1 to get help.

; | Cleansater Pte Lid

Connect

100 Cecil Street,

12th Floar, The Globe,

Singapors DE3632 U Ve
UEM Mo

B5-B2206530 GST Mo

E5-B220E540 GST Req. Date:

zales@cleanwater. com G5T De-Reg. Date:

January 2020 Current Financial Year.

Twelve Last Month in Financial ear

2 | Lozal Company =
20010421 0H|

2020

: December

Clearwater Pte Ltd.mpo
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B. Setup E-Invoicing service via ABSS Connect portal
If E-Invoice service not already setup in ABSS Connect portal:

1) User need to visit ABSS Connect portal. User can access ABSS
Connect portal via Help > Login to ABSS Connect.

2) Enter the user id (email) and password which has been registered
via ABSS Premier / ABSS Accounting, and hit‘Login’ button.

NNECT
Login
Emaul
Password *
Forgot password?

3) After login, user will see company name display on top left. If user
have registered multiple companies using same login ID, then user
may select company by click on User icon on top right, and list of
companies will display.

e[  F

s /
EE

Test v23.0 2018 data

test payment 1st build
% Payments history ABC Company Pte Ltd

Payments trends by month

- test 2
uy

test wifi 2
@

4

GCompany Profile &
e

Profile -

Reset Password =

Logout 0]
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]

4) Click on <§()’Connect’ button from left pane, it will display option
connect to Pagero, an e-invoice access point service provider
which connect to PEPPOL network.

User have to enable this connection in order to use e-invoice
service.

* Pre-requisite: Please ensure Company UEN already fill up in Company
Profile, via user icon on top right corner

E-Invoicing IRAS Singapore
Ensble E-Invoicing vis Submit sll your IRAS tax
.
i P GER Peppol network submissions online
INLAMD REVENUE
AUTHORITY
OF SINGAPORE

5) User will then need consent to Pagero for e-invoicing service, user
required to Sign, fill In the contact person detail and upload the
company stamp.

| agree that Pagero Singapore is authorized to register for a
PEPPOL Identity and undertake transmission/routing of E-
Invoices for and on behalf of ABC Ltd (123)

—

Name *

Account1

Designation *

E-Invoice Username *

Choose / Drop company stamp Browse

Selected file

www.andrecorpl.com/abss-accounting-software
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6) Once Save the details, user will receive the welcome email from
ABSS Connect, as well as welcome email from Pagero Online. User
have to click on the activation link provided in Pagero welcome
email, agree to the license term and then provide a password to
login.

\ C. Customer / Supplier Card File
: New field “Peppol ID.” has been added into Customer / Supplier Card
File Information screen, user required to enter Peppol ID in card file
v prior to sending or receiving invoice. This refers to ID that

Sender/Recipient registered under PEPPOL network.

EF ABSS Premier - [Card Information] - m] =
[ File Edit Lists

CUSTOMER /
SUPPLIER
CARD FILE

Command Centres  Setup  Reports  Window Help - 8 X

Card Details ' Payrment Detalls IContaclLDg' Jobs 'H\stom

Test Company 777 A/F Balance o $3,727.50

Profile

Sale Layout: |Service =l Credit Lirnit: $0.00
Frinted Farm: H|
Inwoice Deliverny: | To be Printed =l
Item Price Level: | Basze Selling Price =l
Income Account: =l UEM Mumber: | 200377777R
Feceipt bemao: Taux ID Mumber: | 200977777R
Salesperson: El TaxCode: (SR 5| Standard-rated sup
Sale Comment: = Freight Tax Code: |SR | 5| Standard-rated sup
Shipping hethod: = [ Use Customer's Tax Code
Custorner Biling F ate: $0.00 Excluding Tax Peppol ID: || 2009777778
r— Customer Terms Information
Payment is Due: | Day of Month after EOM =] % Discount for Early Payment: | 0%
Discount Date: | 1st =l % Monthly Charge for Late Payment: | 0%
Balance Due Date: |30th =] Yolume Dizcount 32 | 0%
(& Actions
% ABSS Premier - [Card Information] — O x
E8 File Edit Lists Command Centres Setup Reports Window Help - & X

Frafile Card Details ! Payment Details ' Contact Lag ' Jobs ' Histary
Test Company 666 AP Balance = $2.461.00
Purchase Layout: | Service = Credit Limit $0.00
Frinted Form: = Lwailable Credit [$2.461.00]
Purchase Order Delivery: | Ta be Printed =l Currently Past Due: $0.00
Expenze Account: | 61000 |5 Accounting & Audit Fees UEN Mumber: | 200966666F
Papment Mema: Tax 1D Mumber:
Purchase Comment: ‘ El TaxCode: |TX |5l Purchases with G5
Shipping Method: = Freight Tax Code: | TX |5 Purchases with GS°
Supplier Biling R ate: $0.00 Excluding Tax [T Use Supplier's Tax Code

Cost per Hour: $0.00 Peppal 1D || 200965666R

— Supplier Terms Information

Papment is Due: | Day of Month after EOM =] % Discount for Early Payrment: | 0%
Discount Date: | 1st =l
Balance Due Date: | 30th =] Wolume Digcount %2 | 0%

& Actions

Note: PEPPOL (Pan-European Public Procurement On-Line) E-Invoicing
refers to automated direct exchange transmission of invoices between
software systems of buyer and supplier. User can Send E-Invoice to their
customer or Receive E-Invoice from their supplier as long as sender and
receiver both registered under PEPPOL network.

www.andrecorpl.com/abss-accounting-software
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D. Send e-Invoice to Customer
A 1. Sales Service Invoice Screen
New “Send” / “Re-send” button for e-invoice been added to Sales
Service Invoice screen, this button will only activate after user

registered with ABSS Connect portal, and also entered Peppol ID
into the customer card.

SEND “Send” button will display when open invoice that have not send
E-INVOICETO via e-invoice before.
CUSTOMER “Re-send” button will display when open invoice that has send via

e-invoice before.
[7 Sales - Edit Service ==

Customer =»: Test Customer 1 Terms o> Net 30th after EQ W Tax Inclusive

Invoice #: | 00000007
Date: |9/41/2020

Destination Cauntry: Custamer PO #:
Description Aot Amaunt
test iy 41000 $100.00

Salesperson Subtatak $100.00
Comment Freight: $0.00

Ship Wia; Tax o $6.54
Promised Date: Total Amount: $100.00

Joumal Mema: |Sale, Test Custarner 1 Applied to Date: $0.00
Refenal Source: F
Irvoice Delivery Status: ‘ To be Printed = Balance Due: $100.00

(U Save as Hecumng| & Reimburse ‘ -;l- Payment ‘ RES Spel| ‘

Help F1 SendTo | Jounal Layout Register

Fields required fill-up for e-invoice service

- Card ID field

- Contact field under “Address 2: Ship To” address
- Peppol ID field

abss www.andrecorpl.com/abss-accounting-software n
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2. Checking e-Invoice Status

User can view the e-Invoice delivery Status from menu item File >
Process e-Invoice/e-Bill select Sync e-Invoice Status.

2 ABSS Premier - [Sync e-Bill / e-Invoice Status] = O x
[ File Edit Lists Command Centres Setup Reports  Window Help -
" Spnc e-Bil % Sunc e-nvoice Status
Dated From: |1 To: | 22/ /2020 T Swnc
Drate Doz 1D Supplier Mame EBalance Status
2140142020 |00000005 Test Company 777 $2.140.00 | Sent J
2140142020  |00000006 Test Company 777 $321.00 | Sent
2140142020  |00000007 Test Company 777 $1.070.00 | Sent
2140172020 |CNZ210102 Test Compary 777 $0.00 | Sent
17/01/2020 |00000003 Test Company 777 $0.00 |Sent
1440142020 |000000CT Test Company 777 $214.00 | Sent

E. Send e-Credit Note to Customer

User can also send Credit Note to customer via Settle Returns & Cred-
its process, current e-Invoice service only support credit settlement
with fulfilled below conditions: -

i) credit note that settled single invoice only and
ii) credit note amount must be fully settled and

SEND iii) settlement do not incur discount and finance charge
E-CREDIT NOTE
To CUSTOMER [7 Settle Returns & Credits E@

Customer o Test Company 777 1D #: | 5J000002

Credit drnaunt: |00 Date: | 20401/2020

tema: | Test Company 777: Credit from 00000004

Cust PO# Statusz Date Amount Discount Tatal Due Amount Applied
|P0123454 o Open 14./01./2020) £214.00 $214.00

PO123455 o Open 17/ /2020 $250.00 $250.00 $250.00

Total Applied: $250.00
Finance Charge: $0.00
Credit Amount: $250.00

™ Include Closed Sales Out of Balance: $0.00

| £

abss www.andrecorpl.com/abss-accounting-software 12
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SYNC E-BILL
FROM SUPPLIER

abss
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F. Sync e-Bill from Supplier

1. e-Bill Tax Type Mapping

For incoming Bill from supplier, as pre-requisite, system required a
completed e-Bill Tax Type Mapping in order to import e-Bill or
e-Debit Note. It is compulsory for user to do the tax type mapping
prior to import e-Bill or e-Debit Note.

User can click on File > e-Bill Tax Type Mapping.

File Edit Lists Command Centres Setup

New Ctrl+N
Open File Ctrl+0
Close Window Esc
Print... Ctrl+P
Print Setup...

Default Fonts...

Back Up...

Restore...

Verify Company File...
Optimise Company File
Active Workstations

Purge Closed Invoices

Start a New Year

Import Data b
Export Data b
AccountantLink b
ABSS Payments

e-Bill Tax Type Mapping

Process e-lnvoice/e-Bill
Sign Out

Exit

[EZ e-Bill Tax Type Mapping EI@

Local zupply

Customear Accounting supply

Zero-rated supply

Exempt supply [Regulation 33]

Exempt supply [Mon regulation 33]  |EN3
Deem supply

Out of scope

Mon GST registered

Other tax code

www.andrecorpl.com/abss-accounting-software
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2. Sync e-Bill/e-Debit Note from Supplier

To import e-Bill/e-Debit Note from supplier, user can go to File >
Process e-Invoice/e-Bill function, and select Sync e-Bill option.
After specify Date From and Date To, and click [Sync] button,
system will start made API call to import bill and credit note
records, transaction that contains error such as unmatched
currency code, missing supplier reference ID will be tracked in
error log file. User can then rectify the problem and rerun the sync

process.
2 2BSS5 Premier - [Sync e-Bill / e-Invoice Status] - m} x
E3 File Edit Lists Command Centres Setup Reports  Window Help -8 %
& Sync e-Bil " Sync e-lnvoice Status
Dated From: | 01401/2020 Q= 2201 /2020 \?} Sync
Date Doc D Supplier Mame Balance Status
21/01/2020 00000007 Test Company 66 [SGD] 1070.00 | IMPORTED J

Notes: When sync e-Debit Note, if the incoming debit note carry a bill
reference number that matched with the Bill Number for the same
supplier in the data file (bill number to be offset), system will automati-
cally create the Debit Note transaction as well as Settle Returns & Debit
transaction. Else if bill reference number not found, system will just create
the Debit Note record without offset the bill record.

abss www.andrecorpl.com/abss-accounting-software 14
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1. Export to Excel xIsx file

All report that currently contains Sent To Excel option, can now export
and saved directly to MS Excel file format with .xIsx extension, without
the needs to launch the Excel application, open the file for viewing
before they get saved. This is to ease user who does not have MS
Office installed in their local workstation.

£7 Index to Reports [E=NE=
| 4
Accounts Eanking' SaGI:sTTfax I Sales | gl“?:i:] I Purchaszes I Inventary | Card | Custom
Hame For each account, dizplays the total debits and credits
Accounts s for the zelected period and the balance at the end of
Accounts List Summary that period.

Accounts List Detail
Account Transactions [Aocrual]
Account Histor [Officelink]
General Ledger [Summary]

General Ledger [Detail] r_ B )

Trial B alance | ﬂ J

Linked Accounts | f
Balance Sheet w /

Standard Balance Sheet
Multi-Period Spreadshest
Multi-Period Budget Spreadsheet - |

|
;?/ :*EJ

5w
Help F1 Frint

@ View Sample Custorise

Dizplay

Excel..
Email...
Fas...
FOF...

HTHL...
Tab-Delimited Text File...
Epmma-S epa[ated Teut File...

Encel ¥ Fil..

2. GST F5 Return [Detail] report - enable the Drill In feature

In this release, user can click the transaction line in GST F5 Return
[Detail] report and drill into the transactions source window to view
the record details.

3. Free Trial and Sample Data File

- Transaction Limit - All non-activated trial data and sample data file
(Clearwtr.myo) now carries a limit of maximum 800 transaction lines
for trial purposes. Once exceeded limit, that trial data file will auto-
matically become READ ONLY.

- Free Trial Period - trial period of non-activated data file now set to
7 days only, after which data file will become READ ONLY. To
continue using that data, user have to activate it.

4. Non-Unicode Compatibility

We have also improved the support on non-unicode Simplify Chinese
characters, where user now able to view Chinese characters in
description fields.

www.andrecorpl.com/abss-accounting-software
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